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520	
  Educational	
  Research	
  |	
  Spring	
  2014	
  
Feel free to contact me: Kate Zoellner, Education, Human Sciences and Psychology Librarian 

kate.zoellner@umontana.edu, 243.4421 or 800.240.4939, Mansfield Library 325 
Research guides: http://www.lib.umt.edu/research/subject-guides 

 
 

Objectives	
  
§ Become familiar with key library services for graduate research. 
§ Understand the role and structure of subject terms in database organization, as well as strategies to narrow 

and broaden your search. 
§ Identify indexes and databases in your field, journals, and open access literature. 
§ Describe the process of tracking citations backwards and forwards. 
§ Explore the functions of research management systems. 

 
 
Library	
  Services	
  

• Interlibrary Loan http://www.lib.umt.edu/ILL 
• Document Delivery http://www.lib.umt.edu/DocDel 
• Study Carrels http://www.lib.umt.edu/forms/carrel/index.php 
• Research Management Systems – EndNote Basic and RefWorks 
• Workshops http://libguides.lib.umt.edu/workshops 

 
Literature	
  Reviews	
  
In reviewing the published literature, the aim is to explain what ideas and knowledge have been gained and shared 
to date (i.e., hypotheses tested, scientific methods used, results and conclusions), the weakness and strengths of 
previous works, and to identify remaining research questions: A literature review provides the context for your 
research, making clear why your topic deserves further investigation. A literature review involves both the literature 
searching and the writing. The purpose of the literature search is to: 

• reveal existing knowledge 
• identify areas of consensus and debate 
• identify gaps in knowledge 
• identify approaches to research design and methodology 
• identify other researchers with similar interests 
• clarify your future directions for research 

 

From: Conducting a literature search. (2003). In Library studies 301H: Information research methods and systems. Retrieved 
from http://bit.ly/aFt1cs 

 
A systematic review and meta-analyses involve a number of discrete steps and often comprise an entire article (a 
literature review is more often one section of an article): 

• question formulation; 
• finding studies; 
• appraisal and selection of studies (e.g., methodology, trial type, demographics, time period); 
• summary and synthesis of relevant studies; and 
• determining the applicability of results. 

 

From: Glasziou, P., Irwig, L., Bain, C., & Colditz, G. (2001). Systematic reviews in health care: 
A practical guide. Cambridge: Cambridge University Press. 
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Research	
  Resources	
  
Note no one resource searches all literature; thorough research requires searching multiple resources. 
 

Database	
   Coverage	
  Dates	
   Content	
  

CINAHL 
(Cumulative Index 
to Nursing & 
Allied Health 
Literature) Plus 
with Full Text 
CINAHL Headings 

Indexes back to 
1973, Most full 
text from the 
1990s-present 

Full text for more than 760 nursing and allied health journals as well 
as 130 Evidence-Based Care Sheets, 170 Quick Lessons (concise 
overviews of diseases and conditions that outline effective treatment 
options), and books; Indexes more than 4,900 journals. 

Dissertations & 
Theses Full Text, 
ProQuest 

Coverage from 
1861-present; 
Full text from 
1997-present 

Over 3 million records – over 1 million in full text. 
 
See also UM’s e-thesis, dissertation and professional paper project 
http://www.lib.umt.edu/etd 

Education 
Resources 
Information 
Center (ERIC) 
Thesaurus of ERIC 
Descriptors 

1966-present Over 1.5 million records covering all education levels as well as tests, 
measurement, and evaluation; Indexes articles, conferences, meetings, 
government documents, theses, dissertations, reports, audiovisual 
media, bibliographies, directories, and books. 

Educational 
Administration 
Abstracts 

Coverage from 
1966-present 

Roughly 200,000 abstracts and citations to educational administration 
literature, including edu. leadership, edu. management, edu. research, 
and related areas. 

PsycINFO 
Thesaurus of 
Psychological Index 
Terms 

Coverage mostly 
1890-present 
 

Over 3.3 million records; Abstracts and citations to the scholarly 
literature in the psychological, social, behavioral, and health sciences. 

PubMed 
Medical Subject 
Headings (MESH) 

1950-present Abstracts and citations to approximately 20 million biomedical 
literature items from MEDLINE, life science journals, and online 
books; approximately 5,400 journals published in more than 80 
countries are included. 

Web of 
Knowledge/ 
Web of Science 

1898-present Indexes over 1,950 journals from 50 social science disciplines, as well 
as 3,300 scientific and technical journals, and conference proceedings. 
This index is the online version of the Social Sciences Citation Index, 
Science Citation Index, and Arts & Humanities Citation Index. 

F 
Other Recommended Databases include: 

• Electronic Books: eBook collection on EBSCOhost (formerly NetLibrary), ebrary, OverDrive, Springer 
• Education-focused: Education Full Text, Educator’s Reference Complete, JSTOR, Professional 

Development Collection, PsycArticles, PsycINFO, ScienceDirect, Taylor & Francis, Tests in Print 
• Health & Human Performance-focused: Health and Wellness Resource Center and Alternative Health 

Module, Health Reference Center Academic, Journals@Ovid, SAGE, ScienceDirect, SPORTDiscus, Wiley 
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Journals	
  
If you are looking for a specific article (e.g., from a reference list) or a specific journal, the first step is to find out if 
the library subscribes to that journal, either online via a database or in print. Enter the name of the journal in the 
main search box on the library homepage, then choose Journal Titles from the Search In pull-down menu. This will 
show you if the library provides access to the journal in a database, in UM Print Holdings (paper copies), and or 
indicate that the library does not subscribe to the journal. If the library subscribes to the journal, be sure to check 
the dates of coverage that are available. If the library does not have a subscription to the journal you can request 
specific articles from the journal via Interlibrary Loan (http://www.lib.umt.edu/ILL). If the library only owns the 
journal in paper you can request that it be scanned and emailed to you via Document Delivery 
(http://www.lib.umt.edu/Docdel). 
 

 
Cheung, S. S., Petersen, S. R., & McLellan, T. M. (2010). Physiological strain and countermeasures with 
firefighting. Scandinavian Journal Of Medicine & Science In Sports, 20(Sppl. 3), 103-116. 
 
Short, C., & Martin, B. N. (2005). Case study: Attitudes of rural high school students and teachers 
regarding inclusion. Rural Educator, 27(1), 1-10. 
 
Choose one of the articles above and answer the following questions: 
• Can you access it online via the library’s subscription databases? 
• Can you access it in print in the library? 

 
 
If you want to know what journals are highly regarded in your field of study, one measure is impact factor. You can 
locate journals with high impact factors in the database Journal Citation Reports (JCR). You can search for a 
specific journal, or locate journals by publisher or subject in JCR. For each journal you will see how many articles 
were published in it, how many times articles from the journal were cited, a one-year and five-year impact factor 
ranking, and additional metrics. Note that JCR does not cover all published journals. Also note that the increased 
sharing of research online via blogs, faculty websites, institutional repositories, etc., has led individuals to develop 
alternative metrics for measuring scholarly impact (e.g., http://altmetrics.org/manifesto/). 
 
Open	
  Access	
  Literature	
  
Open-access (OA) literature is digital, online, free of charge, and free of most copyright and licensing restrictions. 
OA is a kind of access, not a kind of business model, license, or content. OA is compatible with copyright, peer 
review, revenue (even profit), print, preservation, prestige, quality, career-advancement, indexing, and other features 
and supportive services associated with conventional scholarly literature. The primary difference is that the bills are 
not paid by readers and hence do not function as access barriers. The legal basis of OA is the consent of the 
copyright holder (for newer literature) or the expiration of copyright (for older literature). Because OA uses 
copyright-holder consent or the expiration of copyright, it does not require the reform, abolition, or infringement of 
copyright law. The campaign for OA focuses on literature that authors give to the world without expectation of 
payment. Many OA initiatives focus on publicly-funded research. OA is compatible with peer review, and all the 
major OA initiatives for scientific and scholarly literature insist on its importance. The chief difference between 
them is that OA journals conduct peer review and OA repositories do not. This difference explains many of the 
other differences between them, especially the costs of launching and operating them. 

From: Open Access Overview, Peter Suber, http://www.earlham.edu/~peters/fos/overview.htm 
 
Select resources: DOAJ (Directory of Open Access Journals) http://www.doaj.org/; National Institutes of Health 
Public Access Policy Details http://publicaccess.nih.gov/policy.htm 
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Research	
  Strategies	
  
Before you begin entering terms in a database, it can be helpful to follow the first five steps below: 

1. Understand your research question. 
2. Identify the major concepts in your question. 
3. Identify potential terms that correspond to those concepts.* 
4. Select alternative terms (narrower, broader, or related) to use if your initial search is unsuccessful. 

• In ERIC use the Thesaurus of ERIC Descriptors; in PsycINFO use the Thesaurus of Psychological Index 
Terms; in PubMed use MeSH (Medical Subject Headings). 

5. Determine logical (Boolean) relationships between terms.** 
6. Begin the search. 
7. Look at a few documents. 
8. Revise and refine search based on initial results.*** 

 

From: Walker, G., & Janes, J. (1999). Online retrieval: A dialogue of theory and practice (2nd ed.). Englewood, CO: Libraries Unlimited. 
 

* Identify the potential terms that represent the concepts of your research question. 

concept	
  &	
  synonyms	
   concept	
  &	
  synonyms	
   concept	
  &	
  synonyms	
  

achievement motivation 
determination 
ambition 
drive 

adolescents 
teens 
youth 

 

** Determine logical (Boolean) relationships between terms. Boolean operators include: and, or and not. 
Search: achievement AND (motivation OR determination OR ambition OR drive) AND (teen* OR adolescen* OR 
youth) 
 
*** Revise and refine search based on initial results. 

too	
  many	
  sources	
   not	
  enough	
  sources	
   sources	
  not	
  available	
  
at	
  Mansfield	
  Library	
  

  Ask your professor or 
librarian for assistance in 
locating locally available 
materials, use Interlibrary 
Loan. 

 
Cited	
  Reference	
  Searching	
  
If you want to know who has cited a specific article search Web of Knowledge/Web of Science or Google Scholar. 
 

 
Cairney, T. H. (2000). Beyond the classroom walls: The rediscovery of the family and community as 
partners in education. Educational Review, 52(2), 163-174. doi:10.1080/00131910050077051  
 
Hillman, C. H., Castelli, D. M., & Buck, S. M. (2005). Aerobic fitness and neurocognitive function in 
healthy preadolescent children. Medicine & Science in Sports & Exercise, 37(11), 1967-1974. doi: 
10.1249/01.mss.0000176680.79702.ce 

 
Answer the following questions: 
• How many times has it been cited according to Web of Science? 
• How many times has it been cited according to Google Scholar? 
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Research	
  Management	
  Systems	
  
Research management systems can help you manage your research and format citations. You can use the web-based 
tool to: create your own personal database to keep track of your research articles, documents, websites, etc.; import 
citation information from a variety of resources into your database; automatically generate a bibliography in a variety 
of styles (e.g., APA, ASA, Chicago, MLA); and add in-text citations to a paper in a variety of styles. The two web-
based tools the library provides are EndNote Basic and RefWorks. The table below provides basic information to 
get you started using either EndNote Basic or RefWorks. Find our more at: 
http://libguides.lib.umt.edu/endnoteweb and http://libguides.lib.umt.edu/refworks 
 
	
   EndNote	
  Basic	
   RefWorks	
  

Access	
   Via the “Databases, A-Z” link on the homepage. Via the “Databases, A-Z” link on the homepage. 

Capacity	
   50,000 references; top 20 bibliographic styles Unlimited references; 800 bibliographic styles 

Set	
  up	
  an	
  
account	
  

Requires the use of your official UM email 
address. Your password must include at least 
one letter, number, and symbol. No special code 
is required for off-campus access but you need 
to initially register for an account from an on-
campus location. 

Requires the use of your official UM email 
address. Off-campus access requires a Group Code 
that will be sent to you when you set up your 
account and can be re-sent to you if you send an 
email from your university account to 
refworks@umontana.edu. 

Add	
  
citations	
  

Manually under the “Collect” menu, “New 
Reference.” Export data from various databases, 
usually under “Export” or “Save Citations.” In 
some instances this is seamless (e.g., using Web 
of Science), in other instances you need to 
download the data and then use the “Import 
References” option under the “Collect” menu. 

Manually under the “References” menu, “Add 
New” or via the “New Reference” button. 
Export data from various databases, usually 
under “Export” or “Save Citations.” In some 
instances this is seamless (e.g., using CSA 
databases), in other instances you need to 
download the data and then use the “Import” 
option under the “References” menu to add the 
reference data. 

Organize	
  
citations	
  

Use the “Organize” menu, “Manage My 
Groups”, to group references into folders by 
topic, project, etc. A citation can be placed in 
more than one folder. Folders can be shared 
with other EndNote Web account holders. 

Select the “New Folder” button. A citation can 
be placed in more than one folder. Select the 
“Organize & Share Folders” tab to make 
changes. Folders can be shared with RefWorks 
and non-RefWorks account holders via email, 
URL, or in UM’s RefWorks RefShare area. 

Find	
  
citations	
  in	
  
your	
  account	
  

Use the “Quick Search” menu on the “My 
References” page. 

Use the “Search” box. Citations can also be 
sorted in a number of ways such as by author, 
title, and journal. 

Create	
  
in-­‐text	
  
citations	
  

Requires you to download the “Cite While You 
Write” plug-in for your computer that works 
with MS Word programs on PC and Mac 
applications. Find the utility under the “Format” 
menu – “Download Installers.” 

Requires you to download a utility program to 
your computer called “Write-N-Cite” that works 
with MS Word programs on PC and Mac 
applications. Find the utility under the “Tools” 
menu. 

Bibliography	
   Under the “Format” menu choose 
“Bibliography.” 

Use the “Bibliography” menu or the “Create 
Bibliography” button. 

Get	
  help	
   Tutorials are available at 
http://www.youtube.com/user/EndNoteTraini
ng; “Help” menu and “Getting Started Guide”. 

Tutorials are available at 
www.youtube.com/proquestrefworks;“Help” 
menu. 

	
  


